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Value-Added Reseller (VAR) Language

Oracle Retail VAR Applications

The following restrictions and provisions only apply to the programs referred to in this section and
licensed to you. You acknowledge that the programs may contain third party software (VAR
applications) licensed to Oracle. Depending upon your product and its version number, the VAR
applications may include:

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services Corporation
(MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail
Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications.

(ii) the Wavelink component developed and licensed by Wavelink Corporation (Wavelink) of
Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile Store Inventory
Management.

(iii) the software component known as Access Via™ licensed by Access Via of Seattle, Washington,
and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags.

(iv) the software component known as Adobe Flex™ licensed by Adobe Systems Incorporated of
San Jose, California, and imbedded in Oracle Retail Promotion Planning & Optimization
application.

You acknowledge and confirm that Oracle grants you use of only the object code of the VAR
Applications. Oracle will not deliver source code to the VAR Applications to you. Notwithstanding
any other term or condition of the agreement and this ordering document, you shall not cause or
permit alteration of any VAR Applications. For purposes of this section, "alteration" refers to all
alterations, translations, upgrades, enhancements, customizations or modifications of all or any
portion of the VAR Applications including all reconfigurations, reassembly or reverse assembly, re-
engineering or reverse engineering and recompilations or reverse compilations of the VAR
Applications or any derivatives of the VAR Applications. You acknowledge that it shall be a breach
of the agreement to utilize the relationship, and/or confidential information of the VAR
Applications for purposes of competitive discovery.

The VAR Applications contain trade secrets of Oracle and Oracle's licensors and Customer shall
not attempt, cause, or permit the alteration, decompilation, reverse engineering, disassembly or
other reduction of the VAR Applications to a human perceivable form. Oracle reserves the right to
replace, with functional equivalent software, any of the VAR Applications in future releases of the
applicable program.
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Send Us Your Comments

Oracle Retail Macro Space Management, Product Studio User Guide, Release 13.3.2

Oracle welcomes customers' comments and suggestions on the quality and usefulness of
this document.

Your feedback is important, and helps us to best meet your needs as a user of our
products. For example:

= Are the implementation steps correct and complete?

* Did you understand the context of the procedures?

* Did you find any errors in the information?

*  Does the structure of the information help you with your tasks?

* Do you need different information or graphics? If so, where, and in what format?
= Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us
your name, the name of the company who has licensed our products, the title and part
number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to
check that you have the latest version of the document and if
any concerns are already addressed. To do this, access the
Online Documentation available on the Oracle Technology
Network Web site. It contains the most current
Documentation Library plus all documents revised or
released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com
Please give your name, address, electronic mail address, and telephone number
(optional).

If you need assistance with Oracle software, then please contact your support
representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your
Oracle local office and inquire about our Oracle University offerings. A list of Oracle
offices is available on our Web site at www.oracle.com.


http://www.oracle.com/




Preface

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are
hearing impaired.

Related Documents

For more information, see the following documents in the Oracle Retail Macro Space
Management Release 13.3.2 documentation set:

Oracle Retail Macro Space Management Administration User Guide

Oracle Retail Macro Space Management Administration Module Online Help
Oracle Retail Macro Space Management Configuration Module User Guide
Oracle Retail Macro Space Management Configuration Module Online Help
Oracle Retail Macro Space Management Data Importer User Guide

Oracle Retail Macro space Management Data Importer Online Help

Oracle Retail Macro Space Management Fixture Studio User Guide

Oracle Retail Macro Space Management Fixture Studio Online Help

Oracle Retail Macro Space Management Merchandiser User Guide

Oracle Retail Macro Space Management Merchandiser Online Help

Oracle Retail Macro Space Management Planner User Guide

Oracle Retail Macro Space Management Planner OnlineGuide

Oracle Retail Macro Space Management Product Studio Online Help

Oracle Retail Macro Space Management Planner User Guide

Oracle Retail Macro Space Management Report Designer User Guide
Oracle Retail Macro Space Management Report Designer Online Help
Oracle Retail Macro Space Management Release Notes

Oracle Retail Macro Space Planning Install Guide

Oracle Retail Macro Space Planning License Information

For more information on In-Store Space Collaboration see the following documents in the
Oracle Retail In-Store Space Collaboration Release 13.3.2 documentation set:

Oracle Retail In-Store Space Collaboration Release Notes
Oracle Retail In-Store Space Collaboration User Guide
Oracle Retail In-Store Space Collaboration Online Help

Xi


http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:
https:/ /support.oracle.com

When contacting Customer Support, please provide the following:

= Product version and program/module name

= Functional and technical description of the problem (include business impact)

= Detailed step-by-step instructions to re-create

= Exact error message received

= Screen shots of each step you take

Review Patch Documentation

When you install the application for the first time, you install either a base release (for
example, 13.3) or a later patch release (for example, 13.3.2). If you are installing the base
release or additional patch releases, read the documentation for all releases that have
occurred since the base release before you begin installation. Documentation for patch
releases can contain critical information related to the base release, as well as information
about code changes since the base release.

Oracle Retail Documentation on the Oracle Technology Network

Documentation is packaged with each Oracle Retail product release. Oracle Retail
product documentation is also available on the following Web site:
http:/ /www.oracle.com/technology/documentation/oracle_retail.html

(Data Model documents are not available through Oracle Technology Network. These
documents are packaged with released code, or you can obtain them through My Oracle
Support.)

Documentation should be available on this Web site within a month after a product
release.

Conventions

Xii

Navigate: This is a navigate statement. It tells you how to get to the start of the procedure
and ends with a screen shot of the starting point and the statement “the Window Name
window opens.”

This is a code sample
It is used to display examples of code


https://support.oracle.com/
http://www.oracle.com/technology/documentation/oracle_retail.html
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Logging in to Product Studio

Logging in to Macro Space Management Modules

When a user first attempts to access a Macro Space Management module, the Log In
dialog box will appear.

T User Login

User Mame:  [Example

Passiicrd: | suneene
ok I Caneel Change Passwerd >

This requires the user to enter a User Name and Password. If these are correct, the user
will be able to access the desired module. After the initial log in, information will be held
in Security Server. Users will therefore be able to access all other Macro Space
Management modules they have permissions for without the need to log in again. If the
user enters an incorrect user name or password, a warning will result.

Security Server ‘

10* Incorrect Username and Password combination, Please try again.

If the user attempts to log into a module for which they do not have permissions for, a
warning will appear and the log in attempt will be terminated.

Access denied @

f e 1 You do not have permission to login,
Product Studio will now close,

Note: The permissions for which modules can be accessed
are configured in the Administration module.

Password Changes

Macro Space Management can be configured to require password changes at specified
intervals. If one of these intervals has been exceeded, the user will be asked to change
their password the next time they log in. This can be done by means of the Change
Password >>> option on the Log In dialog box. This will reveal another part of the
dialog box where the changed password can be entered and confirmed.



How Passwords and Privileges are Configured

(@ User Lagin .

Utser Mame: |§,.:ﬂm|-j¢

Password: | ssssene

e

oK | Cangel |[s";:';_;a';;_jgs.;;—;g‘;;&a';f;";l

Meve Password: |

Canfirm Mew Pessword: |

How Passwords and Privileges are Configured

Passwords and privileges are configured in Macro Space Management's Administration
module.

Note: Access to the Administration Module is normally
restricted to a limited number of users. This is because the
Administration Module can be used to set a wide variety of
parameters affecting how Macro Space Planning operates.

Access rights to the Macro Space Management modules are set using the Functional
Security option.

EFundiclnal Security |2 |@
File View Help
w P BB M
£ User Groups | roup Retaorships |
[=1-54 Al
-4 Admin

- ¢ Equipment Planner

- R Equipment Plarning Manager
- ¢® Europe

¥R I55C Reader

+.- R I55C User

#- B merchandse Flanner

- 4R merchandse Planning Manager
@B north America

- 4R Restof workd

- ¢® standard User

14/03/2014 | 09:24

Users are assigned to User Groups in the User Groups Tab. Which modules a User Group
can access is specified in the Group Relationships tab. A user's privileges thus depend on
what user groups they are assigned to.

Logging in to Product Studio 2



Security Server

| Fixture Studio
Equipment Module
User 1 o Planner User |
Group Flanner
Module
| Product Studio
Merchandise | | Mgl
User 2 + Flanner User |
el | Merchandiser
Module

In the above example, User 1 is only a member of the Equipment Planner user group.
Accordingly, their access is restricted to the Fixture Studio and Planner modules. User 2
is a member of the Equipment Planner and Merchandiser Planner user groups. They
have wider access and can use the Fixture Studio, Planner, Product Studio and

Merchandiser modules.

Security Server

Security Server is a Macro Space Management process that runs in the background and
is normally not visible to users. When running, it can be seen in the Processes tab of
Windows Task Manager as the AVT5SecurityServer.exe *32 process.

P

= Windows Task Manager
File Options View Help
Appicaﬁm:: Processes | Services IPerﬁerenn: | Mebworking Ileers |
Image Name Lser Mame  CPU Memary (Private ...
AdSync.exe pwells a0 6,132K
ApMsgFwd.exe pwells ao 2,304 K
ApntEx.exs pwells an 2, 195K
Apeint.exs pweells ao 298K
armsvc.exe *32 SYSTEM ao 995 K
audiodg. exe LOCAL... 00 12,376 K
AVT SAdmin,exe *32 pwvells an 32052K
AVTSSacurityServer.exe ¥32  puelk ao 55,200 K
ETTray.exe pwiells oo 3,704 K
btwging. exe SYSTEM oo 18490 K
conhast.exe SYSTEM an 983 K
conhast exe SYSTEM ao 1,408 K
conhost.exe SYSTEM Jale] 1408 K
4 | i | r
[¥] show processes from sl users [ End Frocess
Processes: 105 CPU Usage: D% Physical Memory: 31%

-

-

How Security Server operates is shown in the following flowchart.

3 Oracle Retail Macro Space Management Product Studio User Guide



Security Server

User opens application
from shortout or start
menu

|

Security Server starts —

Log In dialog box
appears

User Logs in with User

™| Name and Password

T

p

Security Server
validates against info

|-

in database

Security Server holds
information on
privileges

=

User can access other
modules they have
rights for

.

Security Server
automatically closes
when user exits

o &~ DN

The user opens a Macro Space Management module from a shortcut or the Windows

start menu.

Security server starts but remains in the background.

The Log In dialog box appears.

The user types their user name and password into the Log In dialog box.

Security Server validates the user name and password against the information held
in the database. If they are correct and the user has sufficient privileges, the Macro
Space Management module opens.

Security Server holds information on what other privileges the user has in Macro

Space Management.

If the user attempts to access other modules, Security Server will check the
information it holds and allow or deny access as required. This means that a user
only has to log into Macro Space Management once per session.

When the user exits the last Macro Space Management module, Security Server also

closes.

Security Server and Application Errors

On occasion a Macro Space Management module might encounter a significant error and
automatically close. Because the closure was not user initiated, Security Server does not
close but remains open in the background. If the module that unexpectedly closed is
reopened, Security Server will contain information incompatible with the restart and
further application errors will result.

In the event of a Macro Space Management module failing unexpectedly, carry out the
following actions:

1.

Save the information in any other Macro Space Management modules that are open
and close those modules.

Open Windows Task Manager, , select the Processes tab, highlight the
AVT5SecurityServer.exe *32 process and click End Task.

When Security Server has closed, the required Macro Space Management modules

can be restarted.

Logging in to Product Studio 4



2
Overview of Macro Space Planning
Macro Space Planning

The Macro Space Planning Application (which includes the Product studio module) is
described in the diagram below.

Macro Space
Management

Store Planning

Planner

Merchandiser

Store Manager

Admin Module In-Store Space Collaboration
Store Planning

Configuration
Module

Planning
Database

ISSC

Data Importer

Fixture Studio

Product Studico

Report
Designer

MSM Batch
Tools

5 Overview of Macro Space Planning



Product Studio and Associated Business Processes

Macro Space Planning

Macro Space Planning consists of two applications sharing a common database: Macro
Space Management and In-Store Space Collaboration. Macro Space Management is
intended for use at headquarters and has functionality not replicated in In-Store Space
Collaboration. In-Store Space Collaboration is designed to be portable and can be used
(via the Internet) at stores within a retail organization.

Macro Space Management

Macro Space Management consists of two sorts of modules: store planning modules and
support modules.

1. Store Planning Modules

Store Planning can be carried out in Planner (AutoCAD environment) or
Merchandiser (Virtual Reality environment). Store Manager, used to administer the
store hierarchy, can be accessed from either Planner or Merchandiser.

2. Support Modules
The support modules are used for three main purposes: to configure Macro Space
Management, to configure the varying libraries of information and to operate batch
processes.
— Configuring Macro Space Management is carried out using the

Administration module for global changes and the Configuration module for
local, user specific changes.

— Libraries of information maintained include the fixture and gondola libraries
(Fixture Studio), product library (Product Studio) and the planogram library
(planogram design within the Merchandiser module).

— Batch tools include Data importer (for bulk import of data) and Report
Designer (configuring planogram reports for bulk output)

In-Store Space Collaboration

In-Store Space Collaboration uses a common database with Macro Space Management.
ISSC is more portable than MSM and is often deployed to stores to allow store managers
to become involved in the store planning process. It can also be used to ensure
compliance with store plans.

Product Studio and Associated Business Processes

Product Studio is integrated into the Macro Space Planning business processes. This is
shown on overview in the diagram below.

Overview of Macro Space Planning 6



Product Studio and Associated Business Processes

Macro Space Management
Store Planning
Planner
Merchandiser | |
3 Party
Product
Store Manager Database
t
v 4
MSM Batch Oracle Data
Tools —+ Data Importer Integrator
3
Adrmin Module
acro
.| Space
“| Planning
Configuration Database
Madule
Fixture Studio In-Store Space Collaboration
Store Planning
Report
Designer

Relationship with third-party Databases

Data on products is often held in a third-party database. This data needs to be brought
into the Macro Space Planning database so that it can be used within Macro Space
Management and In-Store Space Collaboration.

This is can be accomplished by means of Macro Space Management's Data Importer
module. Because data is generally brought into the application at regular intervals, Data
Importer is normally run automatically by a batch process.

Alternatively product data can be brought in as part of the planogram import process.
This is done via ODI (Oracle data Integrator). ODI is normally run automatically by a
batch process.

7 Oracle Retail Macro Space Management Product Studio User Guide



Displaying the Product Hierarchy in Planner, Merchandiser and ISSC

Note: It is possible to return data from the Macro Space
Planning database to the 3rd Party Product database via a
tool like Oracle Data Integrator. One example of this might
be returning product adjacencies, so that the performance of
a product can be analyzed while taking into account the
effect of other products that were close to it.

Product Studio and the Imported Data

Although it is possible to manually set up a product hierarchy, the majority of retail
organizations import product information from a third party database. Product Studio
thus serves two functions:

1.

It allows users within Macro Space Management to see full information on the
imported products and their hierarchy.

It enables Macro Space Management users to add supplementary information to that
imported from the third-party database.

Using Products and their Hierarchy in Macro Space Planning

The product hierarchy is used in three places within the Macro Space Planning suite;

1.

In the MSM Planner Module where products can be placed down to SKU level as
placeholders: this specifies that a product is on a particular fixture, but gives no
information as to position or quantity.

In the MSM Merchandiser module where products can be placed down to Display
Style level: this specifies the position and quantity of that product on a specific
fixture.

In In-Store Space Collaboration. Products can be placed down to Sub-class level as
placeholders in Top Graphical View and down to Display Style level in Front
Graphical View.

Using Products within Planograms

Although it is possible to place products as individual items within a floor plan, it is
more usual to place them within planograms. Planograms enable a precise arrangement
of shelving and merchandise to be placed in exactly the same format within multiple
stores. This has the following benefits:

1.
2.

Product arrangements can be standardized across a retail organization

Placement of planograms is far quicker than placement of the individual equipment
and products

Specialist planogram designers can seek to maximize profitability by designing
planograms that are as attractive as possible to customers - this is not possible if a
store is merchandised by placing individual products.

Displaying the Product Hierarchy in Planner, Merchandiser and ISSC

The product hierarchy imported into and configured in Product Studio can be used to
place products in the Planner and merchandiser Modules and in In-Store Space
Collaboration.

Overview of Macro Space Planning 8



Displaying the Product Hierarchy in Planner, Merchandiser and ISSC

Planner and Merchandiser
The Product Hierarchy can be seen in the Object Browsers in both the Planner and

Merchandiser modules. All levels of the hierarchy are available, although products can
only be placed down to SKU level in the Planner module. The example below shows the

Object Browser in the Planner module.

W

Achve date; 02042014

LM S a2 @
Pmduch’m‘

\il [ Feod and Drink .
i & Bakery
= [l Bread
- [B8 Erown Bread
s | Granary Losf|
i -3 Multiseeded Loaf i
i @0 Whalemeal Loaf
i G [ White Bread
i =l Cakes
i @ [ Rolls |

Kp[| Merchandising |:ncmnng[ fones

]

Properties

Mame Value
Type  [item |
Mame Granary Loaf
Description  Granary Loaf
Code 000757 B
Brand
Colour Lavender

F Object Browser

The properties displayed are dependent on the Custom SQL in the Macro Space Planning
Database (AVITB_CUSTOM_SQL table). This can only be modified by an Administrator

with database privileges.

In-Store Space Collaboration
The Product Hierarchy can be seen in the In-Store Space Collaboration object browser.

The hierarchy is only displayed down to Item level in Top Graphical view, so the lowest
levels of the hierarchy are not available for selection in that view. The full Product
Hierarchy can be seen in Front Graphical View and Shelf Graphical View.
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Displaying the Product Hierarchy in Planner, Merchandiser and ISSC
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The properties displayed are dependent on the Custom SQL in the Macro Space Planning
Database (AVITB_CUSTOM_SQL table). This can only be modified by an Administrator

with database privileges.
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3
Overview of Product Studio

About Product Studio

Product Studio allows users to create and maintain a hierarchy of products. This
hierarchy is then used in the Planner and Merchandiser modules and in In-Store Space
Collaboration.

Data can be imported from third-party software, data can be manually entered, or some
combination of the two can be used.
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Product Studio Menu Options

The Menu Bar has the following options.

File Menu

The File Menu gives the user access to various saving and exit options.

2 Product Studio

| Fle Edit Weew Window Help

Save Ciri+5

Save Al
Cloge
Close Al

Configure F&
Ext
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Product Studio Menu Options

Edit Menu

View Menu

Save - saves the currently active product definition.
Save All - saves all currently open product definitions.
Close - closes the currently active product definition.
Close All - closes all currently open product definitions.
Configure (F6) - opens the Configuration Module.

Exit - closes Product Studio.

The Edit menu allows the user to modify the hierarchy.

Fle | Edr Vew Window Help

J—

=

Add
Edit
Delete

Import Product Images

Cut Cirl %
Copy Cirl+C
Paste Cirl ¥

Add - adds another level to the hierarchy, adding a child object to the currently
selected node.

Edit - opens the currently selected node in the hierarchy for editing.
Delete - deletes the currently selected note in the hierarchy.

Import Product Images allows the user to bulk import product images. (This is
discussed in more detail in the section in importing product images).

Cut (<Ctrl + X>) - removes the selected item from the hierarchy and puts it on
the clipboard.

Copy (<Ctrl + C>) - copies the selected item in the hierarchy and puts it on the
clipboard.

Paste (<Ctrl + V>) - takes the current item on the clipboard and pastes it as a
child object to the currently selected node.

The View Menu gives users access to varying information.

Fla Edt | View Window Help

Find Cirl+F
Refresh F5
Show Extra Info Cirl+M

Display Product Tres
wwlwwﬁm
Desplay Style Types
Preduct Image Configuration

Display Deleted Products
Materials

Find - calls the Find dialogue box.

Refresh - refreshes the hierarchy with the latest information from the database.
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Overview of Product Hierarchy

= Show Extra Info - toggles the Product Description into view as well as the
Product Name.

= Display Product Tree - toggles the Product Tree on or off.
= Display Newly Imported Products - display a list of recently imported products.
= Display Style Types enables a user to configure the list of Display Style Types.

= Product Image Configuration enables a user to configure how the application
stores the product images used for Display Style level merchandise.

= Display Deleted Products - displays a list of products that have been deleted
from the Product Tree.

= Materials - allows users to configure the way products display in Box or
Textured Box form in Merchandiser.

Window Menu

The Window Menu allows the user to arrange any dialogue boxes open in Product
Studio.

Fila Edit View | Window Help
Tile Ver tcally
Tile Horizontally

Cascade
Minimise Al

Tile Vertically aligns all open product dialogue boxes vertically.
Tile Horizontally aligns all open product dialogue boxes horizontally.
Cascade aligns all open product dialogue boxes diagonally.

Minimize All minimizes all open product dialogue boxes.

o > 0N

Restore All maximizes all open product dialogue boxes.

Help Menu

The Help Menu calls help and allows the user to verify the version of the software in use.

Fle Edit Vew Window  Help

Contents F1
About

Overview of Product Hierarchy

The Product hierarchy can be built up using a series of levels. Some levels are mandatory
(yellow) and some are optional (blue).
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Overview of Product Hierarchy
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When constructing the hierarchy, there are just three dialogue boxes involved.

Dialog box Associated Levels

Product Company, Group, Division, Department, Class, Sub-Class, Style and Item
SKU SKU

Display Style  Display Style

The hierarchy is set up relative to the Product Root. It is set up in stages:

Stage  Action

1 Set up Company, Group, Division and Department Levels
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Hierarchy Information

Stage  Action

2 Set up Class

3 Set up Sub-Class

4 Set up Style, Item and SKU Levels
5 Set up Display Styles

Each child is added by clicking on the parent level and selecting 'Add Product' from the
right click menu.

Hierarchy Information

Hierarchy Information can be added at the Company, Group, Division, Department,
Class, Sub-Class, Style and Item levels.

[OFroduct x|

Type: Jsub class =]

Pdame: [Examphe

Desmphion: Swample =]
it

Brand: j
=

Gnde: [12345678

Chent Code: Ii

Category Roles  payne =]

Strategy: |standard Preduct =]

Menufachwer:  [eonanc product =]

ke IGemncF‘rud.-ct __‘:J

Status: [Flarred ]

Colours 5280 N

een [ Froduct Sublias: =]

ok | caesl |

Parameter Comment

Type Can select Company, Group, Division, Department, Class, Sub-Class, Style and
Item levels.

Name Enterable by user.

Description Enterable by user.

Brand Enterable by user.

Code Enterable by user.

Client code Enterable by user.

Category Selectable from a drop down list. The list can be configured using the Category

Role Role option in the Administration Module.
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Placeholders and Display Styles

Parameter Comment

Strategy Selectable from a drop down list. The list can be configured using the Strategy
option in the Administration Module.

Manufacturer ~ Selectable from a drop down list. The list can be configured using the
Manufacturers option in the Administration Module.

Supplier Selectable from a drop down list. The list can be configured using the
Manufacturers option in the Administration Module.

Status Selectable from a drop down list. The available statuses are configured using the
Status option in the Administration Module.

Color Selectable from a standard color pallet.

Icon Selectable from a drop down list. The icon will default to a color specific to each
level, but can be manually overridden.

Placeholders and Display Styles

Products can be placed with varying levels of detail.

Placeholders

Placeholders are used at all levels in the hierarchy above Display Style level. They are
used to show the presence of merchandise without giving any information as to its
quantity, orientation, etc. Placeholders can be used to show represent any level from the
product hierarchy. For example, when first planning a store, they could be used to
represent the departments whose merchandise will be placed on specific fixtures.
Similarly, when planning progresses to another level of detail, placeholders could be
used to represent the sub-classes of product that will go onto specific fixtures.

For example a placeholder could be placed at Department level to indicate that a specific
section of equipment has been allocated for the sale of clothing. Later, this placeholder
could be replaced by one at Class level to indicate a specific section of equipment has
been allocated for the sale of men's shirts.

In the Planner module placeholders can only occupy the full fixture.
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Placeholders and Display Styles

il

In the Merchandiser module, placeholders can be used to represent the product types
that will occupy a fixture (left hand fixture in the diagram below). Alternatively, they can
be used to represent the product types that will occupy specific shelves (middle fixture).

j g I#:'u F_.t:'ft. ’i-ft. N

iy S iy

Display Styles
Display styles describe the physical form of a SKU being placed. They can only be placed
in the merchandiser module (right hand fixture in the diagram above). If a display style
is placed, it gives full information on the position, number, physical form and orientation
of the product being placed.

Note: If Display Style level products are placed in
Merchandiser, they will not appear in Planner.
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Deciding On How to Identify the Product

Deciding On How to Identify the Product

When setting up the Product hierarchy, it is important to have a single, unique way of
identifying the product. This is generally determined by how the product is indexed in
other software used by a retailer. For example, stock control and/or re-ordering systems
might refer to the product by its UPC or by its SKU Code.

It is important that Macro Space Management use the same method of identification. If
date is imported into the product hierarchy, this information will be included
automatically. For manual entry, this is set by the UPC Type drop down list in the SKU
dialog box. The mask for these is set in the Administration Module.

3 Product SKU - Example SKU - B

Detads | physcal | Enancial | Guston |

teame: [Exampls S0
Dgserpton: Example SKU =
=
LPC Type Anythng - BublchDate:  [3; mawch 2011 =l
Code: [12345678 EffectveDate:  [07 son 2011 =l
T2 Expiry Diate: [01 tanuaey 2012 =]
CategoryRoke:  [otne | Rank: [ o=
Strategy: [standara Proauct | Import ldentfer: O
Manufacturer: |Genenc Preduct | Sy Hamn
N e T i
e facuve = CreatonOate: 31 March 2011
fLeon l_l Procuct SEU _:! Created By: o
Erand; [Exampie Last Moddfied Date: 31 March 2011
Sub-brand: ;f_,a—m.e 2 LastModfied By:  pw
Chent Code: Im

Chant Barcode: |123455;rﬁ

Deciding on the structure of the hierarchy

General
The generic hierarchy can have up to 10 levels, 5 of them mandatory:

Level Comment

Company Optional

Group Optional

Division Optional

Department ~ Mandatory
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Deciding on the structure of the hierarchy

Level Comment
Class Mandatory
Sub-Class Mandatory
Style Optional
Item Optional
SKU Mandatory
Display Mandatory
Style

As product data will be generally imported from third-party software, the required
Macro Space Management hierarchy should be planned before the first import so that
data is imported into a standardized hierarchy.

Note: There will be problems with the Macro Space
Management Data Import module if the hierarchy does not
conform to a standard architecture.

Making the Hierarchy User Friendly

The Product Hierarchy consists of a series of levels which should be laid out in a way
convenient for and familiar to store planners.

LowCost LowCost
Lompany Supermarkets Supermarkets
- L L
Y Y Y
Department Frozen Househaold
K K K
Class Ready Meals Electrical
S 3 3
Sub-Class Pizzas Batteries
- - -
Y X X
SKU Three Cheese Duracell Aaf
K K K
Display Style Boxed Hung

Configuring the hierarchy in the optimum manner can save considerable time and effort
when products are being placed in Macro Space Management store plans.

Note: Any level in the hierarchy can be renamed to customer
requirements by Oracle.
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‘Unknown' Levels in Hierarchy

‘Unknown’ Levels in Hierarchy

The Product hierarchy contains nodes called Unknown Category, Unknown class,
Unknown Sub-Class, and Unknown Sub-Sub-Class.

]|

B Al

- Clothing
# 4| Eectrical
- 2 G
=23 Unknown Calegory

= = Unknown Class

[=1-‘=8 Unimown SubClass
# Bl Unknown SubSubClass

These nodes in the hierarchy are used for when products are imported prior to importing
new planogram designs. It may be that some of the products being imported do not map
to existing nodes in the product hierarchy.
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4

Interactions

between Product Studio and
Other Modules

Product Studio and Other Modules

Product Studio interacts with other Modules and with In-Store Space Collaboration.

Macro Space Management In-Store
Space
Admin Config Collaboration
Module Module

=1=

Product IS5C
REA R Tod | Studio "| Application
| ]
! '
Flanner Merchandiser
Madule Madule

Administration Module

A number of lists of data used in Product Studio are configured in the Administration

Module.

Option Comment

Category Role Allows the user to configure the list of Category Roles that can be assigned
to a product.

Manufacturers Allows the user to configure the list of manufacturers (and suppliers) used
to specify products.

Product Code Types  Allows the user to specify the masks for UPC's.

Ranges Allows the user to configure the ranges for temperature scales and weights
that can be allocated to a product.

Strategy Allows the user to configure the list of Category Roles that can be assigned
to a product.

Tax Codes Allows the user to configure the list of available Tax Codes that can be
allocated to a product.

Styles Allows the user to add, edit or delete styles for products.

Units Allows users to configure the units used for defining products.

User Defined Allows users to specify the User Defined Attributes required for products.

Attributes
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Administration Module

In addition, Products marked for deletion can only be permanently purged using the
Purge option in the Administration Module.

Configuration Module

The locations of the directories for Image Capture and Image Root are specified in the
Directories tab in the Configuration Module.

Data Import

Data can be imported from third-party software by with the Data Importer module, or by
using Oracle data Integrator (ODI). If necessary, it can then be configured with additional
information required by Macro Space Management.

Planner

The Product Hierarchy appears in the Object Browser and can be searched/selected from

using the Object Grid.

Products can be placed down to SKU level as placeholders.

Merchandiser

The Product Hierarchy appears in the Object Browser and can be searched/selected from

using the Object Grid.

Products can be placed down to SKU level as placeholders or as Display styles.

In-Store Space Collaboration

The Product Hierarchy appears in the Object Browser.

Products can be placed down to Item level as placeholders

Administration Module

A number of lists, etc, used in Product Studio are configured in the Administration
Module. In addition, Products marked for deletion can only be permanently purged
using the Purge option in the Administration Module.

Note: Only users with the appropriate privileges may
directly access the Administration module. However, the
lists of Manufacturers and Styles can be configured by users
with access rights to Product Studio.

Option Comment

Category Role Allows the user to configure the list of Category Roles that can be assigned
to a product.

Manufacturers Allows the user to configure the list of manufacturers (and suppliers) used
to specify products.

Product Code Types Allows the user to specify the masks for UPC's.

Ranges Allows the user to configure the ranges for temperature scales and weights
that can be allocated to a product.

Strategy Allows the user to configure the list of Category Roles that can be assigned

to a product.
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Administration Module

Option Comment
Tax Codes Allows the user to configure the list of available Tax Codes that can be
allocated to a product.
Styles Allows the user to add, edit or delete styles for products.
Units Allows users to configure the units used for defining products.
User Defined Allows users to specify the User Defined Attributes required for products.
Attributes
Category Role

The list of Category Roles is configurable from the Merchandising menu in the
Administration module. This will bring up the Category Role dialog box, allowing users
to add, edit or delete from the list of Category Roles.

10X
Fie Edit Help
g | > L
Descrgtion ___ _[Code
|Destination DM
Foutne HH
Cormmesnience Cv
Seasonal 5E
Flagshep FP
Cash Machine M
4| |

Manufacturers
The list of manufacturers is configurable from the General Menu in the Administration
module. The option may also be accessed from the Product Studio module by clicking
the button to the right of the Manufacturers drop down list in the product hierarchy at
any level from Company to Style.

23 Oracle Retail Macro Space Management Product Studio User Guide



Administration Module

Status:
Colowr
[eon:

auppber

=]
i
0 L K

|12395678

——
|Routne |
[standard Product =l
| Genenc Product
| Generic Product
ore? <]
C—

I. Frodhect SubClass EI

Ok I

Cancal

This will bring up the Manufacturers dialog box from the Admin module, allowing users
to add, edit or delete from the list of manufacturers.

O Manufacturers HE=E
o I i -
o Mame / E Code
p LB AT Produdts
| Ganeric Equipmant oz Fixbures
| Generic Product 00 Products
| |keboggs KEL Products
ooy Mlanif actune - Equipment 001 Fixchures
Cr Manufacture - Products 003 Produdts
| g & maniFacturers |onjosfzoin | 21:38 | s
Option  Comment
Name Name of the manufacturer
Code Code for the manufacturer - often used as a look up during data import
Type Type is set to either Fixtures or Products using the drop down list

Note: It is recommended that changes are only made to the
list of manufacturers after consultation with an
Administrator. This is because such changes could affect the
import of data from a third-party database.
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Administration Module

Product Code Types

Product Code Types are only configurable within the Admin Module. The Product Code
Types dialog box is accessed from the Merchandising Menu in the Admin Module.

O produc code Types —SNNM-

B RN o Lol
o B e e

: 12 FRppasesased
Sl Code FEREETEE

| |1gf03fz009 | 14:20 o«

It enables the masks restricting entry of SKU codes at SKU level in the product hierarchy
to be configured. This mask then applies to all manually entered SKU information in the
SKU dialog box.

2 Product SKU - Example SKLU ..EJ

liame: [Example S
Deseription: r-mkw =l
=
LPC Type: Anything - BubshDate: 31 mwch 2011 =]
Code: [12345678 EfectveDate: o7 Ao 2011 =l
LPC: | Expry Date: [o1 sarmary 12 =]
CategoryRole: [ ione =l Bark: [ o=
e [Stancard Produxct = Impoet Identfer: 0
Manufacturer: |Genen: Product = T
N e T oo
e [Actve = CreatonDate:  31March 2011
foen: I_I Prochact SEU _'J Crested By: pw
Brand: [Exameie Last Moddied Date: 31 March 2011
Sub-brand: Fgmg Last Modfied By:  pw
QentCode:  [icoer
ChentBarcode:  [12345678]

=] o |

1. The UPC type can be set from the drop down list.

2. All manually entered codes must then conform to the mask specified in the Admin
module.

Note: the UPC mask will not be applied to data imported
into the product hierarchy.
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Administration Module

Ranges

Ranges can be assigned to equipment (fixtures and shelf objects) and to merchandise

(products at SKU level). When merchandise at SKU or Display Style level is added to a
fixtures or shelf object in the Merchandiser module, the assigned temperature ranges are
compared. If they differ, the merchandiser cannot be placed and a warning will be

generated.

Ranges are configured using the Range option from the Merchandising Menu in the

Admin Module.

B

g [ EFE TS R M

-\ Ranges | Ranceld  Mame l Unit _Mnimum | Masdmum
=-E Temperanre 1 ient Temperature  degrees Centigrade x| 5,00 5,00

-*- Ambient Temperature 2 |2 Frozen Goods degrees Cenbigrade = | =100 -5.00
o Chilled Goods 34 Chiled Goods degrees Centigrade = 0.00 4,00
& Frozen Goods

|Sheming 3 ranges (0271212009 | 13258 -

Once configured, Ranges can be assigned to products in Product Studio in the Physical

Tab of the SKU dialog box.

2 Product SEU - Example SKU

Getsis Bhyscal | Brancal| Qustom |

Pk Size: [ 111

Colour: [16711680 N

Hgminal Colour: |
Hominal Sige: Pedim

Hatch Style: |sokd K|

Flavour: | 1Y

Gender: pisa

Temperatire range: |ambuent Goods =|

M M Urvtg:

I: 1] |?J'J [-;.:-;-,_.._-, Centigrade

x|

[ ]

Cancel

Ranges assigned at SKU level also apply to any associated Display Style products.
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Administration Module

Strategies
The list of Strategies is configurable from the Merchandising menu in the Administration
module. This will bring up the Strategy dialog box, allowing users to add, edit or delete
from the list of Strategies.
-loix|
Fle Edt Heb
g id | % Pt 7
Description | Code
e S
Tuf Defender 0z
Cash Flow Generstee 03
Image Enhanicer 04
Profit Generator 05
4| A
Styles

Styles are used when placing products at Display Style level in the Merchandiser
module. They serve as filters to ensure that products are placed on the appropriate items
of equipment. For example, Ice Cream should only be placed in Freezer units, and not on
open shelving.

The list of Styles is configurable in the Administration Module. The option may also be
accessed from the Product Studio module by clicking the button above the Available
styles pane in the Styles tab of the Display Style dialog box.
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Administration Module

yle - Examphe SKU - Hanging

j——————
This dialog box has three tabs:
1. Style Tab - where the names and types of styles are configured
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Administration Module

2. Style Relationships Tab - where the relationships between styles are determined: in
turn specifying what merchandise can go on what item of equipment

3. Test Tab - this tab allows users to determine what product styles can be placed on an
item of equipment. It also allows a user to determine what equipment an item of
merchandise can be placed on.

Note: It is recommended that changes are only made to the
list of styles and style relationships after consultation with
an Administrator. This is because such changes could
significantly affect how products at Display Style level place
in the Merchandiser Module.

Tax Codes

Tax Codes can be assigned to products at SKU level. They are configured using the Tax
Codes option from the General menu in the Admin module.

= F

]

| || Desoiption | Rate
T A

Reduced WAT
Standard VAT

Tax Froe

15
17.5

|Dfoajz00a | 14:34 s

Once configured, Tax Codes can be assigned to products in Product Studio in the

Financial Tab of the SKU dialog box.

© Product SKU - Example SKU =

Detads | physcal  Erancal | Qustom |

Qurency: Jux stering =l
Prce £ 15.25 =
Com 7~
Brofit &£ I s
Colendar Poriod: [iveer =]
Soles £ | e
uithovement: [~ s
luead Time: |1 Week =
Deysofsiodl: [~
Cost Bosks: rtem |
I Lox Code: [standard Rate ;II

|
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Administration Module

The Tax Code can then be used for calculation or reporting purposes.

Units

The Units dialog box is accessed from the General menu of the Administration Module.

© Units Admin Tool I [=]

Eie Unt Cimersions Help

o [l ® "> ef

| |UnalD Symbol |  Desciption | Feefi | Suffec | Order | Oifsst | S| Factor | Display | Frecision| Mandstory|  Delsuk = |

| 1 ruan Prure: rumber 1.0 00 100 2 M #

2 | 2deg  Babslenian 20 000 002 ¥ 2 ¥ #

Ea|  3jmm pov e 310 000 000 ¥ : ® o

Js B 34 G gramme g S0 0.00 000 = 2 H i

[EELE Blsecord sherdard second H &0 0.00 100 & 2 M ¥

[ 7 charge  electical 70 000 100 & 2 H H

(B2 | & mlengly | melne hmance ed £0 0.00 100 & 2 H ¥

[ LK, Stetlng £ a0 000 100 : ® ]

el Wpe UK perce P 0.0 0.00 00 2 M =

10| 12 U5 Dolla £ 120 000 160 : o =

11| 13cents  UScents 10 000 002 2 ¥ =

12| Mt degioes Corrade c Mo 000 100 2 o o

(13| 15 aF degiees Fabeenbek F 150 -3200 058 2 = =

(14| 15 ggk degiens Kehn 3 160 27115 00 H Z = =

(15| 1b pound b W0 000 045 2 = =

161 2n impeial nch in 200 000 003 M 2 o o

17 2500 imipeenial foot i 250 0.00 (1 2 = E b

| v
It can be used to configure the varying units used in Macro Space Planning. Within
Product Studio, these are directly used in two places:
1. The Currency set in the Financial tab of the SKU dialog box.

O Product SKU - Example SKU = ..ﬂ

UntMovement: | 0=
yead Time: {1 week |
DaysofSupply: | 1 ==
Cost fasis: [1tem x|
Tax Code: [standsrd Rate =l

ol
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Administration Module

2. The weights and dimensions set in the Size and Shape tab of the Display Style dialog

box.
© Product Display Style - Example SKU - Hanging : x|

Description[Example SKU: Exarnle 5K - Hanging =1
5

Chent Code:  [anrner Manufacturer:  |caneric Product |

o Deso S Toe. [ g

Code: [1234s678 Quantity |_fj

Sgllable: W Bequres Power: [~

size 8:Shape | Styles | Images| PegHoles | Qrientation |
‘Weight: |—|:|"";|"I Shape: |IEH.‘JI ﬂ
Welght Uinits: kiograen weight = Colowr: [emean ._4
Length Linits: imperial inch = Material: I "l
Engerspace Above: | = Jumble
uﬁ Factor (%): | ui"

Engerspace Beside: 0=
Length Depth: Heightt:

Size | 12 = | 5= | Ele
Nestng | o= o= 0=
Crush Factor (%): | o=t o={ ] 0=
ap: [ o | o | o+
Min Stadking /Facngs: | 12 1 2=t 1]
Max Stacking | Faangs: [ 5= | = | 14

User Defined Attributes

User Defined Attributes are configured in the UDA (User Defined Attributes) dialog box
accessed from the General menu in the Admin Module.

o]
%5

_ Twe [Nmber | Mame [DataType| Mandatory | Sequence Defoit [Lookps Ij
+ | Bladk

+ Fe

Text 1 Plarogram Designer  Text [yl 1

Text 2 Store Sipe Text O 2 Al Srnall Medurm, ..
| Text 3 Planogram Type  Text o 3 General  EthriciSpecal...

Text 4 Text O o 0

Text 5 Taxt 0 o 0

Text & Text O o i =

I | 26072010 | 1419 ¢
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Configuration Module

Once configured for products, UDA's can be assigned in the Custom Tab of the SKU
dialog box.

Configuration Module

The locations of the directories for Image Capture and Image Root are specified in the
Directories tab in the Configuration Module.
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Configuration Module

[=] Corfiguration
Current Configuraten Profle:  r5cefault
Databases | Opticns {0 | Files | Zones | Fixturing | Merchandisng | Merchandiser | Prafies |
Mame | Path | Loead | cached | & -
ROOT C:\Orade Retai MMy N N
Store Root 1110.157.93, 124\RETAILDATA, - M5P_DEMO_DE\Store Ro... N M add
RF Bin W10.167.93. 124\RETALLDATA - M5P_DEMO_DE'RFBin', N M -
MET W10, 157,93, 124\RETAILDATA - M5 _DEMO_DEMSM| M ] -
[mege Roat W10.167.93. 124\RETAILDATA - M52_DEMO_DB\ImagzR... N N =i
Image Capture C'¥orade Retal\MSM\Image Capture), N M ]
Warking C:'Orade Retal\MSM\Werking | N M =
FlanocgramReoot  Ci'Orade RetalMSM\Planogram Root), N N
Impart Files 1110.167.93. 124\RETALLDATA, - MS?_DEMO_DB Trpert), N ]
Export Files 1110.157.93, 124\RETAILDATA - MSP_DEMO_DE\Export), ] M
[cars C:'Crade Retail\MSM\lcons| N M
LogFies 1110, 157,93, 124\RETAILDATA - M5P_DEMO_DE\LogFles) N N
Help C:'\Crade Retsi MSMHelp) H ]
Archived Fles 1110. 157,93, 124\RETALLDATA, - M5 _DEMO_DE\Archived... N N
EMP C:\Orade Retai MSMEMPY, N M
Textures 1110, 157,93, 124\RETALLDATA, - M5P_DEMO_DE\Textures|, N ]
Image Profiles W10.167.93. 124\RETALLDATA - M52 _DEMO_DE\Imag=P... N N
Imzge Label CtlCrade Retail\Me\Image Labelg), Y N
Sounds 1110, 167,93, 124\RETALDATA - MSP_DEMO_DB\Sounds), N N
Basic Radkina 1110, 167,93, 124\RETALLDATA - M5F DEMO DEBkcks'B... N N 0
@ | Version 13.3.2.00 Database Version 0K I Cancel I

1. Image Capture is where images are stored after being captured by a camera.

2. Image Root is the starting point for storage of images after they have been assigned
to a product.

Image Capture

Image Capture is where images that have been taken with a digital camera or scanned
are stored prior to being imported into Macro Space Planning. The image capture
directory may be either local or on a server. If on a server, images have to be uploaded to
the server before they can be imported into Macro Space Planning

Image Root

The Image Root is always a folder on a server. It serves as the starting point or the
directories that hold the images associated with Display Styles.

Importing Images
Images may be imported either manually or automatically.
Manual image import is done via the Images tab on the Display Style dialog box.
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Data Import

x|

Name [Example SKU - Hanging

Descripion  [Examphe SKL: Exarmle S - Hangng =1
|

Chent Code:  [azcrer Manufactrer:  [genenc Product |

wPc: [ Display Style Type  [Crut ]

Code: | 1234367 Quantity ]_:j

Seflable: =3 Bequires Power: [~

Size Bishape | Styles  Images | PegHoles | Orientation |

Dérectary: [Vpedewno 150\ Application_Data\MsP_DEMO_DE\mage RoatiExa)
Mapping Format: [Box =l B
Import | |Exampte SHLK: Exan | |
Browse for Image |
Left Top
| | |
Back Right Battom

0K | Coancal |

On clicking the Import button, any images that at in the Image Capture directory with a
name matching that specified in the Product Image Configuration dialog box will be
moved to the appropriate sub-directory under the Image Root.

Alternatively, on clicking the Browse for Image button, users will be taken to the Image
Capture directory. After selecting an image it can be 'dragged and dropped' into one of
the six boxes on the right. After being dragged and dropped, the image will be converted
to jpg format and stored in a directory originating from the Image Root.

Note: See the Configuration Module Help File for more
information on how Directories and their paths are
configured.

Data Import

Macro Space Management provides a specialized Data Import module. This allows
product details to be imported from third-party software.
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Planner and Merchandiser

O MSM Data Imporber

Eie Wiew fdmin

[ Sicees_ By Regon

] Product Hiegarchey

[ SEUs

T
[ Festures

[ Plansagram Hieranchy

CIEPOS =

= Impoit Dats

1= )

The way this is done is as follows:

3Pa
pmdurg Flat file o Data
Database — Importer

Macro

Space
Planning
Database

1. Data from a third-party database containing product information is written to a flat

file (XML file, CSV file or fixed Width File).

2. This flat file is read by Data Importer and the information written to tables in the

Macro Space Planning database.

3. The information in the Macro Space Planning database is displayed in the product

hierarchy.

It may be necessary to add other information to the imported data. This could include
information such as dimensions, style relationships or images for 3D Virtual Reality

representation in Merchandiser.

Note: Product information can also be imported as a
separate process (independent of Data Importer) during the
Planogram Import process using Oracle Data Integrator

(ODI)

Planner and Merchandiser

Planner

The Product hierarchy appears in the Object Browser in Planner. It can also be searched

using the Object Grid.

35 Oracle Retail Macro Space Management Product Studio User Guide



Planner and Merchandiser

bbb A AC A - MO FOR BESALE Saarn s Foaneren i

Moddy Cacdatiors Taols  Windos B

Anpn dutnr 002030

= [ oo, Vines and Speets
[ T——
Chiles Fich o e

H ‘R swmd @
"

= | Pretun | Bimagum
; 0 Faod wnd Brind
= - By
kS o et
3 o Caoms
i o 0 Rl
E

3

B

Frarnd vngatsties
Eaghonmwe:

WA W, e (Capad] J el [

st oot

i o oo s o [for | bee
i | — —
"‘ « [ e e e ftar
Progran

Ha=a Yakin
Hama [T rp—rm— :::::; :"'\Em g L : B :

v L o eers s and Lagers 2 2
Chem Ll w nd fentn
;..I,““ ‘,:;:»,;'“ ' 1oy Miend Gy Beens Goos andlages 1 ' -] " [ Saareed 1 » oL
- n 1By Bt ot Bechs Beers, Oderd sndligend 1 ] n n L Samhaoized 1 1 WL
e — l‘lar_:ﬂ‘md_ll‘u"am e : ] = :z :: Eu—vm : : :::
Memstssiorer Sunari st 1By, Wit Vit \ whes [ J = i otre o

-] - "

Effecion e - 0
ooy Oue L1000 3 racoraz \

Ta. Thas file in & Trusvedal Larr

Object Grid

Object Browser

Products can then be placed down to SKU level as placeholders.

Merchandiser

Like Planner, the Product hierarchy appears in the Object Browser in Merchandiser. It

can also be searched using the Object Grid.
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The Product hierarchy can either be placed as placeholders down to SKU level, or as 3D

Virtual Reality objects at the Display Style level.
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In-Store Space Collaboration

In-Store Space Collaboration

The product hierarchy is also shown in the Browser in the In-store Space Collaboration
application.

[=] Admin - [ Small Pratotype Store\Ground Floor\Merchand
B &8 DE35 W@hHm®
Froducts | Flanograms |

I ..j Bak,epf -
-7 Beers, Wines and Spirits
-1_7] Bockie and Mewspaperz i
-i7] Chilled Figh and Meat
-1.7] Condimente and Spicae
-1.7] Frozen Goods
-17] Fruit and Vegelables
-] Kicharmware
-1.7] Packet Goods
=+{_] Breakizst Cereals
i E{ ) Helloggs Breakfas Careals
-] Pesta it

F=h Dina

B e [y SR B S e R T S I

KM | Marchandising  Foduring
m

Propeties

Atribute Value

Name Feloggs Breadast Censels
Description Felogge Breakdas Cameals
Trpe Style

0] 1218

Depardment Faed and Drink

Category Packel Goods
SubLCategony Kefloggs Ereakfas Carezle
Amaunt Placed ft) 0

+ | I G

Key Plan (&)

The hierarchy is only displayed down to Item level.
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Importing the Product Hierarchy

Importing the Product Hierarchy

Planograms

Although it is possible to manually create a product hierarchy, it is more normal to
import that product hierarchy. This is generally done by using the Data Importer module
to import information from a third-party database containing product information. This
import operation can be invoked manually, but it is more normal for it to be run
automatically using a batch scheduling tool.

Before planogram designs involving new products are imported into Macro Space
Planning, any new products required for those planograms must first be imported into
the product hierarchy. This is done separately from a pure product import as it is done as
part of the planogram import process as one of the stages of bringing in planogram
designs using ODI (Oracle Data Integrator).

Frequency of updates

The frequency of updates will determine how current the information is in Product
Studio compared to the third-party database the information is being imported from. The
frequency of imports is in its turn determined by the available time to carry out that
import. If the time is available, product data might be imported on a nightly basis. If time
overnight is restricted by the need to carry out other batch tasks, then it might only be
possible to import updated product information at the weekends.

Note: As the frequency of updates will vary from retail
organization to retail organization, import frequency should
be checked with an administrator if required.

Information updated

Information on products held in the Macro Space Planning (MSP) database can be
updated in varying ways. These include:

1. New Products
Entirely new products can be imported into the MSP database. Examples of this

might include new products from existing suppliers, or existing products being
sourced from different suppliers.

2. Updated Products

Product information on existing products can be updated. Examples of this might
include changes to financial information or to UDAs (User Defined Attributes).

3. Expired Products

Products can be expired (removed from the list of those available). This is done by
setting an expiry date for the product. When placing products in a floor plan, the
expiry date is compared with the Active Date for the floor plan. (This Active Date can
be set at the top of the Object Browser if the floor plan is open - alternatively, it can
be set in the File Properties dialog box for the floor plan in store Manager).
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Importing Products with Planogram Import

If the Expiry Date for the Product is before the Active Date for the floor plan, the
product cannot be placed as it will be obsolete before the floor plan comes into
service.

Expired products can be purged using the Purge option on the Tools menu in the
Admin Module. Products will only be purged (deleted from the database) if there are
no instances of that product in any floor plans (including those at historical status).

Importing Products with Planogram Import

Before planogram designs involving new products are imported into Macro Space
Planning, any new products required for those planograms must first be imported into
the product hierarchy. This is done separately from a pure product import as it is done as
part of the planogram import process as one of the stages of bringing in planogram
designs using ODI (Oracle Data Integrator).
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Product Images

Importing Product Images

Overview of Importing Product Images

There are two ways of importing product images.

© Product Display Style - Goodman LD2271D - Display x|

Name [Goodman LD22710 - Display

Desaiption LD2271D - Display 2l
™ p

Chent Code: | Maufactrer:  [eoneric Product =]

1= [ Display Stle Type [t =]

Code: | psooo2se Quantity [ 1

Spliable: = Bequres Power: [~

Sze ashepe | Styles  Images | peg Holes | Qrientation |

Directory: [VRedevwvO150\Aopication_DataMsP_DEMO_DE'\image RoatfGoo|
Mappng Format: [Box = »J

Import Image amport

Image
Browse for Image -

Import Image

This option is semi automatic. If an image of the correct name exists in the Image Root
specified in the directory tab of the Configuration module, clicking the Import button
will result in the image being moved or copied to the folder under the Image Root
specified by the setting in the Configuration Module.
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Importing Product Images

Browse for Image

This option allows the user to manually browse for an image to associate for the product.
The initial directory opened will default to that specified for Image Capture in the
Directories Tab of the Configuration Module.

Product Image Configuration

The names the product images are stored under are determined in the Product Image
Configuration dialog box accessed from the View menu.

x]
1~ Fisname Bazed Orc |
| " SKU Code
| ™ UPC Code

@ Product Descipbor

1~ Image Sub-Diectoies 1

% Mumbser of charachers to ups for subdiechony I_jﬁ
€ Use M armifachiner

— Diplions -
I Copy e froan capturs dischon bo [mage Root

@ oK, Cancel |

Filename Based On
This radio button determines the name that will be assigned to the image after it has been
imported.
1. SKU Code
The image will be named after a combination of the Display Style type, the SKU code
and the direction the image will be facing.
—  The first character in the image name indicates the Display Style Type. This

information is read from the information specified in the Display Style Type
dialog box accessed from the View menu and will be the single letter in the

Name Field.
=T
+ & X
Hame iptior Code
M Mudtipack MR,
P Palat PAL
T Tray TRY
u Uit UNT

— The next characters in the image name will be the SKU code.

— The final two characters in the image name denote the direction the image
will be viewed from when placed on a display style.
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Importing Product Images

Character  View Direction

1 Front
2 Left
_3 Top
4 Back
5 Right

6 Bottom

M12345678__3 is therefore the image name for a multi-pack display style that will be
displayed on top of the display style when it is represented in the Merchandiser module.

Note: The SKU Code is stored in the Client Code field in the
SKU and display Style dialog boxes.

2. UPC Code

The image will be named after a combination of the Display Style type, the UPC
Code and the direction the image will be facing.

— The first character in the image name indicates the Display Style Type. This
information is read from the information specified in the Display Style Type
dialog box accessed from the View menu and will be the single letter in the
Name Field.

— The next characters in the image name will be the UPC code. (This could be
in a number of formats: for example EAN or GTIN).
— The final two characters in the image name denote the direction the image
will be viewed from when placed on a display style.
3. Product Description

The image will be named after the Product Description in the Display Style dialog
box.

H5000237091807_1 is therefore the image name for a multi-pack display style that

will be displayed on the front of the display style when it is represented in the
Merchandiser module.

Note: These options will be configured when Macro Space
Planning is implemented. If the settings are changed after
images have been imported, the application will look for
images corresponding to the changed settings and all
association with images associated with the old settings will
be lost.

Image Sub-Directories

Image sub-directories will be located under the Image Root specified in the Directories
tab of the configuration module.

1. SKU Code

If SKU Code is selected, the image sub directories will be named after the first 1 - 3
characters of the SKU code depending on the setting on the spin control.

2. UPC Code
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Importing Product Images

If UPC Code is selected, there are two options that can be used.

— If Number of Characters is selected, the image sub directories will be named
after the first 1 - 3 characters of the UPC code depending on the setting on
the spin control.

— If Manufacturer is selected, the image sub-directory will be named after the
digits within the UPC code that represent the manufacturer.

3. Product Description
If SKU Code is selected, the image sub directories will be named after the first 1 - 3
characters of the product description at display style level depending on the setting
on the spin control.

Note: These options will be configured when Macro Space
Planning is implemented. If the settings are changed after
images have been imported, the application will look for
images corresponding to the changed settings and all
association with images associated with the old settings will
be lost.

In the example below, image folders based on the Product Description have been
created below the Image Root.

Folders
= [C5) MSP_DEMO_DE
I Architectural Plans
[==) Archived Files
|2 Blocks
I Export
| Image Labels
I} Image Profiles
=1 IZ) Image Root
1L
I g
= 2L
I 0P
) 233
) 268
I 295

Options

If the Copy Files from capture directory to Image Root option is checked, a copy of the
image file will be placed in the image sub-directory below the Image Root. If unchecked,
the image file will be moved from the Image Capture directory to the specified image
sub-directory.

Manually Importing Images

Images can now be added to a Display Style level product. This is done via the Browse
for Image option on the Images tab of the Display Style dialog box. Images can be of the
jpg, jpeg, bmp, gif, tif and tiff formats.
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Importing Product Images

Note: Images are used in an 'associative' fashion in the
Merchandiser module - no record is stored in the database,
but the application looks for images for specific name stored
in a specific directory when representing the display style in
a floor plan. The Image Name and directory are based in
settings in the Product Image Configuration dialog box
accessed from the View menu.

O Product Display Style - Goodman LD2271D - Display x|

Nome fooodman LD22710 - Display

Desciption  [Goodmans LOZ271D - Display =

B/
Clent Code: | Marwfectwrer:  [Conenc prodt =]
we | DeplyStfeTie [ 3
Sgllable; 15 BequresPower: [~

Sze BShape | Sties  Images | Peg Hoes | Qrientason |

Drectory:  [\Redevsv0 150\ppicanon_Data |52 _DEMO_DB\image Rootooo\
Mapoing Format: [Box | )

for [mage | ]
Browse for Image -—-—""L w

m— PP oviiey |
Image from _/
Image Capture Left o
| | |
Image associated _/
With Product
Back Right Bottom

The required image should be in the Image Capture directory specified in the
Configuration module. On clicking Browse for Image the Browse for Image dialog box
will open. The required image can then be selected.
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Importing Product Images

2]
Look in: | (3 Image Capture o = s o

Gocdmans LD2271D - Display. bmp

[500dmans LD2271D - Display benp =] Qen |
[Images [ jpg peg:" b dwg." g *xfi ") ] Concel_ |

™ Open as ead-orly

&

When the Open button is clicked, the image will appear in the left pane in the Display
Style dialog box. It can then be 'dragged and dropped' to where it is needed on the
product sides.

Note: The number of images required for each product will
depend on settings in the Product Image Configuration
dialog box. If the SKU or UPC options are chosen, up to six
images can be associated, each associated with one side of a
cube. If the Description option is chosen, only one image can
be associated - associated with the front of the Display style.

As the image is 'dragged and dropped' it will be moved to the required folder under the
specified Image Root. The name of the image will be changed to the format specified in
the settings in the Product Image Configuration dialog box (View menu) and the format
of the image will also be converted to jpg.

Note: The options will be configured Product Image
Configuration dialog box when Macro Space Planning is
implemented. If the settings are changed after images have
been imported, the application will look for images
corresponding to the changed settings and all association
with images associated with the old settings will be lost.

Semi-Automatically Importing Images

Images are used in an 'associative' fashion in the Merchandiser module - no record is
stored in the database, but the application looks for images for specific name stored in a
specific directory when representing the display style in a floor plan. The Image Name
and directory are based in settings in the Product Image Configuration dialog box
accessed from the View menu.

If there is an image in the Image Capture directory specified in the Configuration Module
with a name that matches that specified by the settings in the Product Image
Configuration dialog box, when the Import button is clicked that image will be moved or
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Importing Product Images

copied to the sub-directory below the Image Root specified by the settings in the Product
Image Configuration dialog box.

Note: Unlike the Import Product Images option on the View
menu, this will only import product images that match the
specified criteria for this Display Style.

%
Name F251500 - Desplay
Descrption  [FZ5150° - Desglay E

[ F

Chent Code: 12345678 Monufachrer:  [Genenc Product =
W | Display Style Type [t =]
Code: | Quantity | 1=
Sellable: ~ Bequres Power: [~

Sire &.shope | Styles  Imoges | Pegtioies | Qrientation |

Dvectory:  [\JRedevwv0 150\Apphcation_DataMSP_DEMO_DB jimage Root\123)
Mapping Format: [Bo =1 By
Import Image f—————— | [orzsasems v [urzsesems 2o [Uizaessmesieg
Browse for [mage |
Front Left Top

Jurzsesems_app  [unzseseTe S JUL234%678_6.0g

The results will be reported in a dialog box.

X
Images imported: &
ignared: 0

Images
L ]

If the option in the Product Image Configuration dialog box was set to SKU Code or UPC
Code, up to 6 images can be imported for each display style. If the option is set to
Product Description, only a single image will be imported.
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Using Transparency in Product Images

Note: Care needs to be taken that there are no trailing spaces
in the field that is used to determine the image name. For
example if the image name is to be based on the display style
description, if the description has trailing spaces the import
will fail.

Automatically Importing Images

Images are used in an 'associative' fashion in the Merchandiser module - no record is
stored in the database, but the application looks for images for specific name stored in a
specific directory when representing the display style in a floor plan. The Image Name
and directory are based in settings in the Product Image Configuration dialog box
accessed from the View menu.

If there is an image in the Image Capture directory specified in the Configuration Module
with a name that matches that specified by the settings in the Product Image
Configuration dialog box, when the Import Product Images option on the view menu is
clicked that image will be moved or copied to the sub-directory below the Image Root
specified by the settings in the Product Image Configuration dialog box.

Note: Unlike the import button in the Images tab of the
Display Styles dialog box, this will import all product
images that match the specified criteria.

File | Edit View Window Help
Add

E Edit
Delete

Import Product [mages

Cut Cirl+X
Copy Cirl+C

The results will be reported in a dialog box.

%
\i) Impaort Complete,
Images mported: 32
Images ignored: 0

[ oK

Using Transparency in Product Images

Overview of Transparency and Product Images

Note: An alternative to using the technique described in the
section below is use the ability in most image processing
software to turn the background of an image transparent.
This will mean the background will not display in Macro
Space Planning, leaving only the product itself on display.
Consult the help files of your image processing software for
more information.
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Using Transparency in Product Images

Product Studio gives user the option of turning specific parts of the image transparent
when displayed.

*

i

The television on the left has had parts on the image made transparent; the television on
the right has not. Making parts of images transparent can make display styles look more
realistic in the Merchandiser module.

The process of making parts of images transparent is outlines in the flow chart below.

Color parts af Import image Assign image Sections of image
=+ image o ba |— into Product | toDisplay |- will be transparent in
fransparent Studio Style Merchandiser

Set System
Variable

1. The DEFAULT_TRANSPARENCY_COLOUR system variable in the Administration
module is set to a precise RGB value.

2. The parts of the product image to be made transparent are colored the precise RGB
value

The image is imported into Product Studio
The image is assigned to a Display Style

When this Display Style is used in Merchandiser, the specified parts of the image will
appear transparent.

Setting the DEFAULT_TRANSPARENCY_COLOUR System Variable

Note: An alternative to using the technique described in the
section below is use the ability in most image processing
software to turn the background of an image transparent.
This will mean the background will not display in Macro
Space Planning, leaving only the product itself on display.
Consult the help files of your image processing software for
more information.

The DEFAULT TRANSPARENCY_COLOUR System variable is set in the
Administration module. Only users with the correct privileges can access this module.

Note: Users will require the appropriate access rights to
open the Administration module

This is set by selecting the System Variable option from the General menu to bring up the
System Variable dialog box.
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-iDix
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The system variable is set by entering decimal equivalent of an RGB (Red, Green, Blue)
value into the Value text box, pressing Return and exiting the dialog box.

The decimal equivalent of the RGB value can be obtained by opening any dialog box in
the product hierarchy.

© Product - Uncle Ben's Boill in Bag x|

Iype: = =
tame: juncle Ben's Bod in Bag
Rescrption: [incie Ben's Bol n Bag =

b4
Brand: =]

=
Gode: jmum
Chent Code: |_
CategoryRoke:  [ouone =
Swategy: [Standard Product B oy Colour Button
Suppler: |Genenc Product >
o factve =
Colour: fismss —_ -
e m\

1 Colour Yalue
o] owen |

The color value (expressed as a decimal equivalent) can be seen as a color value in the
text box. In the above example, it is 16711935. To find the RGB equivalent click the Color
Button. This will open the Color dialog box. Clicking the Define Custom Colors >>>
button will expand the dialog box. The RGB values can be seen towards the right.
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In the above example the RGB vales are as follows: Red = 255, Green = 0 and Blue = 255.
These values define a Magenta shade.

Note: To convert RGB values to the single value stored in the
database, apply the following formula: DB Value = Red
Value + (Green Value x 256) + (Blue Value x 63536).

Preparing the Image

Note: An alternative to using the technique described in the
section below is use the ability in most image processing
software to turn the background of an image transparent.
This will mean the background will not display in Macro
Space Planning, leaving only the product itself on display.
Consult the help files of your image processing software for
more information.

In order to prepare the image, parts of it must be colored the precise RGB value specified
in the DEFAULT_TRANSPARENCY_COLOUR system variable. This can be done with
most photo editing software. Set the color to be added to the precise RGB values.
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The areas of the image to be made transparent can then be filled with the precise shade of

color.

Area to be made Area colored
transparent with required tint

In the example above, the area by the base of the TV is to be made transparent and has

been colored accordingly.

Once colored, the image must be saved as a bit map (.bmp extension). This is because bit

map images save colors more accurately than a jpg image.

Adding the Image to a Product

Note: An alternative to using the technique described in the

section below is use the ability in most image processing
software to turn the background of an image transparent.
This will mean the background will not display in Macro
Space Planning, leaving only the product itself on display.

Consult the help files of your image processing software for

more information.

The bit map image can now be added to a Display Style level product. This is done via

the Images tab of the Display Style dialog box.
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The image (with added transparency color) should be in the Image Capture directory
specified in the Configuration module. On clicking Browse for Image the Browse for
Image dialog box will open. The required image can then be selected.

Browse for Image £ |

Look in: | (3 Image Capture ¥ « @ -

fSocdmans LD2271D - Display beme =
e N i
™ Open 23 read-orly

e |
_Crenl |

&

When the Open button is clicked, the image will appear in the left pane in the Display
Style dialog box. It can then be 'dragged and dropped' to where it is needed on the
product sides.
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Note: The number of images required for each product will
depend on settings in the Product Image Configuration
dialog box.

As the image is imported into the appropriate folder under the Image Root in the
windows folder structure, it will be converted from a bit map file (.bmp) to a .jpg file.
Every time the image is changed, it must be done as a fresh .bmp file as jpg files do not
store RGB colors as precisely. Re-saving the .jpg file after editing it will almost certainly
change the value of the transparency color to one different from that specified in the
DEFAULT_TRANSPARENCY_COLOUR system variable and the colored areas will not
appear transparent.

Displaying the Image in Merchandiser

Note: An alternative to using the technique described in the
section below is use the ability in most image processing
software to turn the background of an image transparent.
This will mean the background will not display in Macro
Space Planning, leaving only the product itself on display.
Consult the help files of your image processing software for
more information.

If lights are present in the floor plan when the image is displayed in Merchandiser, then
there may be 'reflections’ from the transparent area. This can be seen in the left hand
image below. It is possible to adjust the properties of the image to eliminate the
reflection’. This can be seen in the right hand image below.

The first stage of eliminating 'reflections'’ is to select a display style. Bring up the right
click menu and select Edit Materials...
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Note: Only one display style at a time can be selected.

This will bring up the Load Textures dialog box. Click No.

Object Materials Editor

_Highight Mot | Ok _Cancel |

:I I -:-.: 1ol ermal
HewMatesini || | (604 Pofpaons | Undol]
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Ditusion —

Carry out the following steps:

55 Oracle Retail Macro Space Management Product Studio User Guide




Using Transparency in Product Images

1. Click the Override button

2. Set the Specular slide control to 0

3. (Click OK

(It may be necessary to repeat these actions).
The 'reflection’ will now be eliminated.

Note: These changes are purely present in the floor plan and
will not be saved when the floor plan is saved and closed.

Product Images 56



7

Setting up and Maintaining the Product
Hierarchy

Setting up the Basic Hierarchy

Setting up Company, Group, Division and Department Levels

Company, Group, Division and Department Levels are set up starting from the Product
Root using the Product dialog box. Additional levels can be added using the Add option
from the Edit menu or the right click menu.

(O Prodoct |
Type: Ifmr _ﬂ
Hame: [example
Pesiption: Zwample =]
.l
Brand: = wample d
=
Code: [12345678
Chant Coda: ——
Categery Role: | =]
oy | =]
Manufactirer:  [naneric Product =
Suppber IGenen::P'ru-duct __:J
S_ta'li.r:: Im ﬂ
Coour: [o | P
L |B8 Product Comparny =)
[ o | coen |

The Hierarchy Level Type can be set using the Type drop down list.
The options are in the following sequence:

=  Company (Optional)

* Group (Optional)

= Division (Optional)

= Department (Mandatory)

Once a level has been added, its child will only be available from those levels below it in
the hierarchy.

Only when a Department has been added will the Class option be available in the drop
down list of Hierarchy Level Types.
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Parameter

Comment

Name

The Name is the name of the Company, Group, Division or Department.

Description

The Description is a more informative version of the name.

Brand

The Brand field is used if the children of this node in the product hierarchy
belong to an identified brand of merchandise - for example 'Acme Clothing'.

Code

The Code is a client specified identifier for this item in the product hierarchy. It
would generally contain an item of data from the database the product
information is imported from. For example, it could be the primary key from a
table in the third-party database. This item of data enables the data to be
referenced back to the third-party database.

If planograms are being imported, and this node in the hierarchy is being used as
a placeholder in a planogram, it is assumed this field is unique.

Client Code

The Client Code is another client specified identifier for this item in the product
hierarchy. It would generally contain an item of data from the database the
product information is imported from. For example, it could be the primary key
from a table in the third-party database. This item of data enables the data to be
referenced back to the third-party database.

Category
Role

This option is grayed out and unavailable for these levels in the product
hierarchy

Strategy

This option is grayed out and unavailable for these levels in the product
hierarchy

Manufacturer

The Manufacturer can be set from the drop down list. The drop down list is
configured using the Manufacturers option in the Administration module.
Although access to the Administration module is generally accessed to users with
Administrators privileges, Product Studio users can access the Manufacturers
option by clicking on the button to the right of the text box. This will bring up the
Manufacture's dialog box from the Administration Module, allowing users to
add, edit or delete entries.

O Hanufacturers =lolx|
Bie  Help
o e’
| Hame | Code Type /
| O Manufacture - Equipment ]
i Gcﬂcnc Equipment 002 Fixtures
[Cwn Manufacture - Products 003 Products
| Generic Product 04 Praducts

:r = 1g- .11: TRTE 7

Supplier

The Manufacturer can be set from the drop down list. The drop down list is
configured using the Manufacturers option in the Administration module.

Status

The status shows where product is in its life cycle. It can be set from the drop
down list - the options in this list are configured using the Status option in the
Administration module.

Color

The color can be set from a standard color pallet. When the product is placed in
Planner, Merchandiser or In-Store Space Collaboration it will be displayed using
this color.
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Parameter Comment

Icon The icon is set by default when the hierarchy level is first created, but can be
manually set from the drop down list

Setting up Class and Sub-Class Levels

A Class level in the Products hierarchy can only be set up as a child of a Department and
a Sub-class level in the Products hierarchy can only be set up as a child of a Class.

Both levels are mandatory in the hierarchy, and both are configured by means of the
Products dialog box. They are using the Add option from the Edit menu or the right click

menu.
[Oproduct x|
Type: | 5ub Class =]
lame: [Exampie
Resaiption: = ample =]
=
Brand: j
=
Code: [12395678
Chant Coda: ——
Category Role: IR,cutn: ﬂ
Strategy: |standard Product =]
Marufachrer:  [coneic product =
Supplier |Genen: Prohct _‘_':J
im: IM ﬂ
Cooa [es280 -
kon [ Product SubCisss =]
Kk | cwmes |

Only when a Sub-class has added will the next three options be available in the drop
down list of Hierarchy Level Types.

Parameter Comment

Name The Name is the name of the Company, Group, Division or Department.
Description The Description is a more informative version of the name.

Brand The Brand field is used if the children of this node in the product hierarchy

belong to an identified brand of merchandise - for example 'Acme Clothing'.

Code The Code is a client specified identifier for this item in the product hierarchy. It
would generally contain an item of data from the database the product
information is imported from. For example, it could be the primary key from a
table in the third-party database. This item of data enables the data to be
referenced back to the third-party database.

If planograms are being imported, and this node in the hierarchy is being used as
a placeholder in a planogram, it is assumed this field is unique.
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Parameter

Comment

Client Code

The Client Code is another client specified identifier for this item in the product
hierarchy. It would generally contain an item of data from the database the
product information is imported from. For example, it could be the primary key
from a table in the third-party database. This item of data enables the data to be
referenced back to the third-party database.

Category
Role

This option is grayed out and unavailable for Class level, but available for Sub-
class Level. Category Roles are used to assign what the retailer believes is the
reason customers purchase specific products.

Strategy

This option is grayed out and unavailable for Class level, but available for Sub-
class Level. Strategies are used to assign what the retailers' business objectives are
to the products that will be used to accomplish them.

Manufacturer

The Manufacturer can be set from the drop down list. The drop down list is
configured using the Manufacturers option in the Administration module.
Although access to the Administration module is generally accessed to users with
Administrators privileges, Product Studio users can access the Manufacturers
option by clicking on the button to the right of the text box. This will bring up the
Manufacture's dialog box from the Administration Module, allowing users to
add, edit or delete entries.

R

| 3o Manufactune - Equipment ]
| Generic Equipment 002 Fixtures
| |own Manufacture - Products 003 Praducts
| Generic Product 004 Products

:r == 1g- .11: THTH 7

Supplier

The Manufacturer can be set from the drop down list. The drop down list is
configured using the Manufacturers option in the Administration module.

Status

The status shows where product is in its life cycle. It can be set from the drop
down list - the options in this list are configured using the Status option in the
Administration module.

Color

The color can be set from a standard color pallet. When the product is placed in
Planner, Merchandiser or In-Store Space Collaboration it will be displayed using
this color.

Icon

The icon is set by default when the hierarchy level is first created, but can be
manually set from the drop down list

Setting up Style, Item and SKU Levels

Style, Item and SKU Levels are set up based on the Sub-Class level in the hierarchy. To
add a Hierarchy level, complete the following steps:

1. Right-click and select Add. The Hierarchy Level dialog box will open.
2. Using the drop down list, select one of the following Hierarchy Level Types:

Style (Optional)
Item (Optional)
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— SKU (Mandatory)
Hierarchy

1~ Hisarchy Type

{ e =l

i = = = = I

— From Sub-Class level, the user will be able to add either Style, Item or SKU
levels.

— From Style level the user will be able to add either Item or SKU levels.
—  From Item level the user will only be able to add SKU level merchandise.

Once a level has been added, only its child levels may subsequently be added. For
example, if a user at Sub-class level adds Item as the next level in the hierarchy, it
will no longer be possible to add a Style level above it in that level of the hierarchy.

If Style or Item levels are added in the hierarchy, the Product dialog box will appear.
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Parameter Comment

Name The Name is the name of the Company, Group, Division or Department.
Description The Description is a more informative version of the name.

Brand The Brand field is used if the children of this node in the product hierarchy

belong to an identified brand of merchandise - for example 'Acme Clothing'.
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Parameter

Comment

Code

The Code is a client specified identifier for this item in the product hierarchy. It
would generally contain an item of data from the database the product
information is imported from. For example, it could be the primary key from a
table in the third-party database. This item of data enables the data to be
referenced back to the third-party database.

If planograms are being imported, and this node in the hierarchy is being used as
a placeholder in a planogram, it is assumed this field is unique.

Client Code

The Client Code is another client specified identifier for this item in the product
hierarchy. It would generally contain an item of data from the database the
product information is imported from. For example, it could be the primary key
from a table in the third-party database. This item of data enables the data to be
referenced back to the third-party database.

Category
Role

This option is grayed out and unavailable for Class level, but available for Sub-
class Level. Category Roles are used to assign what the retailer believes is the
reason customers purchase specific products.

Strategy

This option is grayed out and unavailable for Class level, but available for Sub-
class Level. Strategies are used to assign what the retailers' business objectives are
to the products that will be used to accomplish them.

Manufacturer

The Manufacturer can be set from the drop down list. The drop down list is
configured using the Manufacturers option in the Administration module.
Although access to the Administration module is generally accessed to users with
Administrators privileges, Product Studio users can access the Manufacturers
option by clicking on the button to the right of the text box. This will bring up the
Manufacture's dialog box from Administration, allowing users to add, edit or
delete entries.

rr— il
D Help
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Supplier

The Manufacturer can be set from the drop down list. The drop down list is
configured using the Manufacturers option in the Administration module.

Status

The status shows where product is in its life cycle. It can be set from the drop
down list - the options in this list are configured using the Status option in the
Administration module.

Color

The color can be set from a standard color pallet. When the product is placed in
Planner, Merchandiser or In-Store Space Collaboration it will be displayed using
this color.

Icon

The icon is set by default when the hierarchy level is first created, but can be
manually set from the drop down list

If a SKU Level Item is added, the SKU Dialog box will appear. This dialog box is
discussed in more detail in the section on SKU Level information.
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Setting up Display Styles
Display Styles are set up below the SKU level in the hierarchy. To set up a display style,

select the pertinent item at SKU level in the hierarchy, then use Add from the edit menu
or right click menu.
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This dialog box is discussed in more detail in the section on Display Style information.
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SKU Level Information

Overview of SKU Information

The SKU Information is used to configure the information for a specific unit of sale.
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There are four tabs, each holding a different category of information.

Details Tab
The Details Tab is used to configure the details for the product.
x
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Parameter Comment

Name The SKU name

Description A description of the SKU

UPC Type UPC type can be set from a drop down list. The list can be configured using the
Product Code Type option in the Administration Module.

Code The Code for the product.

UPC The UPC for the product - it must conform to the mask set in UPC type option.

Category This option is grayed out and unavailable for Class level, but available for Sub-

Role class Level. Category Roles are used to assign what the retailer believes is the
reason customers purchase specific products.

Strategy This option is grayed out and unavailable for Class level, but available for Sub-
class Level. Strategies are used to assign what the retailers' business objectives are
to the products that will be used to accomplish them.

Manufacturer  Selected from the drop down list - the list can be configured using the
Manufacturers option in the Administration module.

Supplier Selected from the drop down list - the list can be configured using the
Manufacturers option in the Administration module.

Status Selected from the drop down list - the list can be configured using the Status
option in the Administration module.

Icon Selected from the drop down list - the available icons are pre-loaded with the
application and cannot be altered.

Brand The Brand for the product. This might be the manufacturer of a brand of cereals -
such as 'Acme Clothing'.

Sub Brand The sub-brand for the product. This might be a sub division of a brand - such as
Cornflakes

Client Code The Client Code for the product - this equates to the SKU code.

Client The Client Barcode for the product.

Barcode

Publish Date This is the date at which the ordering of this SKU can begin. For example, if this is
a new product it could be available for ordering from 1st June

Effective This is the date that the product will be available for use within stores. This date

Date would be later than the Publish date and would take into account the delay in the
supply chain before it could appear in a store. For example, if the earliest date the
product could be ordered is 1st June, the effective at might be set to 1st July.

Expiry Date This is the date at which the product will be removed from use within stores. This
date would be set (or updated) if this SKU is being superseded by another
product.

Rank Rank is an integer that can be used to rank SKUs in order of preference. It is

primarily of use in the Object Grid, where it can be used as a method of selecting
one SKU in preference to another. (Whether the rank displays in the Object Grid
depends on the custom SQL being used - this can only be changed by an
Administrator with database rights).
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The Effective Date and Expiry Date can also be used to control whether products can be
selected from the Object Browser. This is controlled by the
MERCH_TREE_EFFECTIVE_DATE System Variable. If set to 0 (Off), the Effective Date
and Expiry Date will have no effect on whether products can be selected or not. If set to 1

(On), products with an Effective Date and an Expiry Date after the Active date for the
floor plan (set at the top of the Object Browser, or in the File Properties dialog box in
Store Manager) will be grayed out in the Object Browser and cannot be selected.

The Effective Date and Expiry Date can also be used to control whether products can be
selected from the Object Grid. This depends on the custom SQL being used - this can
only be changed by an Administrator with database rights).

In addition, there is some read only information.

Parameter Comment

Import This field contains an item of data from the database the product information is

Identifier imported from. For example, it could be the primary key from a table in the third-
party database. This item of data enables the data to be referenced back to the
third-party database.

Import This field contains an item of data from the database the product information is

Name imported from. For example, it could be a table name from in the third party
database. This item of data enables the data to be referenced back to the third-
party database.

Import Date This is assigned during data import and identifies date of the specific import that
brought in or modified the product information.

Creation This identifies the date the product information was imported.

Date

Created By This identifies the user who executed the import that brought in the product
information.

Last This identifies the date the product information was last modified

Modified

Date

Last This identifies the user who last updated the product information.

Modified by

Physical Tab

The Physical Tab is used to specify details concerning the physical aspects of the SKU.
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Parameter Comment

Pack size The pack size is the number of items in a pack of the product - it can be set to any
positive numerical value. (Whether the SKU is a single item or a pack is set using
the Cost Basis drop down list in the Financial tab.

Pack Units This is set from a drop down list - the list can be configured using the Units
option in the Administration Module.

Color The color can be set from a standard color pallet. When the product is placed in
Planner, Merchandiser or In-Store Space Collaboration it will be displayed using
this color.

Nominal This field can hold a text description of the product's color - such as Red, Green

Color or Blue. It can be used for information purposes.

Nominal Size

This field can hold a text description of the product's size - such as small,
medium or large. It is used for information purposes.

Hatch Style This field can hold a hatch style for when a floor plan is printed with this product
placed. It is currently not implemented.

Flavor This field can hold a text description of the product's flavor - such as Peppermint
or Vanilla. It is used for information purposes.

Gender This field can hold a text description of the gender the product is intended for -
such a Male, Female or None. It is used for information purposes.

Temperature The temperature range specifies the temperature the product should be stored

Range and displayed at. For the product to place in Merchandiser the fixture or shelf

object it is to be placed on must have an identical temperature range assigned.
Temperature ranges are configured using the Ranges option on the
Merchandising menu in the Administration module.
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Parameter Comment
Max, Min These read only values show the maximum and minimum temperature the
and Units product should be stored and displayed at. It also shows the units those

temperatures are displayed in. Temperature ranges are configured using the
Ranges option on the Merchandising menu in the Administration module.

The text fields such as Nominal Color and Nominal Size can be used within the Macro
Space Planning application. For example, the information could be displayed in the
Summary Window of the Object Browser, or displayed in the Object Grid and used as
filter for selection.

Note: Changes to what is displayed in the Object Browser or
Object Grid can only be made by changing the Custom SQL
in the Macro Space Planning database. This option is only
available to Database Administrators.

Financial Tab
The Financial Tab is used to record financial information on the SKU. Typically this will
be 'static' data based on organization wide averages. More specific information is often
brought in with the Product UDA information for planograms.

%
Detads | physcl  Einongal | ustom |
Gurency: [swig =]
Price £: 15.25 =
Cgst £ 7.5
profit £ s,l:;Il
Calendes Period Neek -
Soles £ [ o=
Uinit Movement: !—50__"2"‘__,
Lead Time: 1 Week -
Doysofswpl: [~ 0=
Cost Bass: Ttem =
Iax Code: Standard Rate -
o] e |

Note: The precise definition of some of the terms described
below varies from retail organization to retail organization.
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Parameter

Comment

Currency

The currency is the unit of measure for the financial values. It is set from a drop
down list. The available values in the drop down list are configured using the Units
option from the General menu in the Administration module.

The selected unit of currency also appears as a suffix in other fields in the dialog: for
example Price £:

Price

The retail price of the SKU.

Cost

The purchase cost of the SKU.

Profit

This is the profit attributable to the SKU. Depending on the organization, it may be
gross profit (sales price less the cost from the supplier), or net profit (profit after
indirect overheads have been taken into account).

Calendar
Period

The calendar period is the time period the financial data is for. This is set using a
pre-configured drop down list.

Sales

Definitions may vary, but sales are typically the average value of sales for a store
within the specified calendar period.

Unit
Movement

This is the number of SKU units that sell during a specific time period.

Lead Time

The delay between placing an order and receiving it. It can be set to any positive
integer.

Unit
Movement

The rate at which the item is consumed. This is often for the time period specified in
the Calendar Period.

Days of
Supply

Definitions may vary, but days of supply is typically total inventory in the system
divided by average daily consumption.

Cost Basis

Cost Basis can be selected from a drop down list. It is set from a pre-configured drop
down list. The options are Item or Pack. if set to Pack, the pack quantity can be set
using the Pack Size spin control on the Physical tab.

Tax Code

Tax code can be selected from a drop down list. The options are configured using
the Tax Code option accessed from the General menu in the Administration
Module.

Custom Tab

The Custom Tab can be configured to hold customer specific items of information. The
list of items displayed can be configured using the User Defined Attributes option
accessed from the General menu in the Administration Module. A maximum of 60 items
can be configured
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This tab enables customer specific information to be assigned to the SKU. In the above
example, there are five check boxes that allow Yes/No options to be set regarding
properties of the product, one line for special instructions and three lines for comments.

This information can either be set manually or (more probably) brought in via a data
import.

Display Style Information

Overview of Display Styles

Display Styles can only be used in the Merchandiser module. They allow products to be
represented on equipment or shelves with differing degrees of accuracy ranging from a
simple box to a virtual reality image.
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Weight: | 1= Shape: [ox =]
Wesght Units: kiogram weight = Colour: 11 E711630 ._
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The dialog box consists of the following parts:

1. A header section that primarily contains information copies from the SKU item that
is its parent.

A Size and Shape tab that describes the physical form of the Display Style

A Styles tab used to specify the style determining which fixtures and shelves the
Display Style is compatible with.

4. AnImages tab that allows the user to associate product images with the Display
Style.

5. A Peg Holes tab that allows users to specify how the Display Style will hang from a
peg (shelf object).

6. An Orientation Tab that will indicate the positions (upright, on its side, etc), that the
Display Style can take up when placed on a fixture or shelf object.

General Information
Reflected through from SKU...
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Parameter Comment

Name The name of the display style is generally the same as the parent SKU with an
addition (such as Hanging or Boxed) to show the physical form of the display
style.

Description The description of the display style is generally the same as the parent SKU with
an addition (such as Hanging or Boxed) to show the physical form of the display
style.

Client Code The client code (if used) will normally be the same as for the parent SKU.

UPC The UPC (if used) will normally be the same as for the parent SKU.

Code The code (if used) will normally be the same as for the parent SKU.

Manufacturer =~ The manufacturer will normally be the same as for the parent SKU.

Display Style  Display Style Type is set from a drop down list. (This list can be configured from

Type the Display Style types on the View menu in Product Studio.

Unit If the display style type is one which holds multiple instances of a SKU item, the

quantity should be set to that value. For example a multi pack might contain 6
items. This information is required for accurate reporting purposes.
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Parameter

Comment

Sellable

The Sellable checkbox indicates whether the display style is for sale or is merely
there to show the product. An example of a non-sellable display style would be
when a television is taken out of its boxed and turned on. This is a flag that can be
set for reporting purposes - for example in a KPIL.

Requires
Power

The Requires Power checkbox indicates in the display style requires power. An
example of this type of display style would be a television that is to be shown

working. This is a flag that can be set for reporting purposes - for example in a
KPI.

]
[ Qusniity | Abgnent | Detsl | Oiierdaion | Propesties
& Facingr ¢ One & Fl  © Other 3=
Depth: ¢ One & Fll € Oiher 12
Stack: & One C Fl € Other 139
'  FRegaed J_— =

Grouped:

108 Basmati Rice 500g Multipack products each of 6
products (648 products total).

Note: If the Display Style quantity is set to anything other
than 1, when the product is placed in Merchandiser, the
Quantity tab of the Add Products dialog box will show the
total number of units of merchandise placed.

¥

In the above example, 9 x 12 (=108) Display Styles has been placed. As each multi pack
contains six SKUs, a total of 648 SKUs have been placed on that item of equipment.

Size and Shape Tab

The Size and Shape Tab allows the user to specify the Size and Shape of the product.
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Parameter Comment
Weight Can be set to any positive numerical value - the units are specified in 'Weight
Units' below.
Weight Units Units are selected from a drop down menu and can be set to metric or
imperial units.
Length Units Units are selected from a drop down menu and can be set to metric or

imperial units.

Finger space
Above

This spin control sets the finger space above the products. At present this
information is for information purposes only.

Finger space

This spin control sets the finger space beside the products. At present this

Beside information is for information purposes only.

Shape Shape is selected from a drop down list. It specifies the Product Block used for
the product, and hence the general type of shape that will be displayed - box,
cylinder, etc.

Color This is the color used for simple representations of the product. It can be

selected from a standard pallet.
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Parameter Comment

Material This is the coloring form used when products are represented when shown as
textured boxes. It is selected from a drop down list. (Materials are configured
via the view pull down menu)

Jumble Factor The Jumble Factor is a factor that can be used to allow for the lower packing
density of loose objects. At present this information is for information
purposes only.

Size Length, depth can be set to any positive numerical value - the units being
specified in 'Length Units' above. The size must be set to a positive value or
the display style will error when being placed in Merchandiser.

Nesting This specifies the degree to which one unit can be stacked inside each other. It
is entered as a positive numerical value.

(For example, 5 vases of height 300 mm and a nesting height of 50 mm would
have a total height of 500 mm).

Crush Factor % This specifies how much the dimensions of soft items (such as cushions) cam
be compressed when stacked. Crush factor does not apply to the top item in
the stack as it is not being compressed.

(Three items of 100 mm height with a crush factor of 25% would have a
combined height of 250 mm: 75 mm + 75 mm + 100 mm).

Gap This is the gap between multiple instances of a product. It can be set to any
positive numerical value - the units being specified in 'Length Units' above.

Half the gap is normally applied to each side of the product. Items stacked on
top of each other will not normally have a height gap.

Min This is the minimum number of products that can be placed in the facing,
Stacking/Facings  depth and height orientations.

Max This is the maximum number of products that can be placed in the facing,
Stacking/Facings  depth and height orientations.

Styles Tab

The Styles Tab allows the user to specify the Style(s) associated with the product. These
in turn determine which fixtures and shelves the product can be placed on. A product
must have at least one style assigned before it can be placed - and that style must have a
defined style relationship with the style on the object on which it is being placed.

Parameter Comment

Available This is the list of styles that can be assigned
Styles to the product

Selected This is the list of styles that have been
Units assigned to the product.

Styles are selected or de-selected using the Selection Option buttons. Styles can be
configured in the Administration Module. The Style Configuration button allows users to
access this option.
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Images Tab

The Images Tab allows the user to specify the Images associated with the product. These
will display when the product is placed in Macro Space Management Merchandiser if the
Draw Products as Graphical option is selected to display the product.

Images can be imported into Macro Space Management (via Data Importer) or manually
selected from the Image Capture directory specified in the Configuration Module.
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The Directory is the directory that the imported image is held in.

The Mapping Format specifies whether the images are to be shown using a box or a cross
format.

In a Box format, the images are placed on each of the six sides of a cuboid, so the left,
right, front back, top and bottom images can be seen depending on which direction the
product is being viewed from.
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Peg Holes

In a Cross format, the images are placed on the sides of a vertically aligned cross. This
allows users to see images when rotating around it in the horizontal axis, but not when
viewing it from above or below. Images that can be associated with a product are found
in the Image Capture directory (specified in the Configuration Module). When assigned,
they are stored in the Image Root and its associated sub-directories.

Note: Full details of how to import images are in the section
on Importing Product Images.

The Peg Holes Tab allows the user to specify the Peg Holes associated with the product.

© Product Display Style - Example SKU - Hanging =
Name [Example 56U - Hanging
Destripton FMM:EMW-W =]
=
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The Peg Hole Toolbar allows users to add a new peg hole to the product, or to delete an
existing, highlighted one.

The Peg Hole Settings allow the user to define the position of the peg hole. This may be
done either using the radio buttons, or by using the spin controls to set the X, Y and Z
offsets.

The Defined Pegs Holes show the settings defined for each peg hole. In this example,
one peg hole has been defined midway across the top of the product.
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The Style Filter is used when multiple styles have been assigned to the product on the
Styles tab. If the fixture or shelf object also has multiple styles assigned, the style filter
can be used to pick which style is preferred.

Orientation Tab

The Orientation tab is used to specify which positions an item of Merchandise can
assume when placed on a shelf object.
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An example where this functionality would be used is for a vase. This would be placed
upright on a shelf, and not on its side. The default orientation is a combination of two
factors:

=  Which side of the product is facing the front of the fixture or shelf - for example
the top or back.

= How that side of the product has been rotated.
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In the above example, the default orientation is 'Front', while rotations of 0 degrees, 90
degrees and 180 degrees are illustrated.

Preferred Orientations

The check boxes in the Preferred Orientations frame can be used to indicate permissible
orientations. There are six orientations that the product can be placed:

= The top of the product could be facing the front of the shelf of fixture.

= The front of the product could be facing the front of the shelf of fixture.

= The bottom of the product could be facing the front of the shelf of fixture.

= The left of the product could be facing the front of the shelf of fixture.

= The right of the product could be facing the front of the shelf of fixture.

= The back of the product could be facing the front of the shelf of fixture.
There are four rotations that can be given to the product.

= 0degrees

= 90 degrees

= 180 degrees

= 270 degrees

These combinations of what faces the front of the fixture or shelf and a rotation are not
unique. For example, 'Front' rotated 90 degrees is the same as 'Left' rotated 0 degrees.

Preferred orientations can be configured by means of the check boxes.

Default Orientation

The default orientation is the orientation the Display Style takes when first placed on a
fixture or shelf object.

The default orientation is configured my means of a radio button.

Note: The orientation functionality can be populated by data
import or manual selection. The information can then be
used for reporting purposes. There is currently no restriction
placed on the orientation when placing a Display Style in the
Merchandiser module - this functionality is in the process of
being developed.

Selecting the orientation when placing the Display Style

The orientation when placing the Display Style in Merchandiser is selected from the
Orientation tab of the Add Display Style dialog box. The orientation tab in the Display
Style dialog box in Product Studio currently places no restrictions on the orientations that
can be selected.
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Note: At present this information can only be used for
reporting purposes - it has no effect on actual product
placement.

Display Style Functionality

Display Style functionality can only be seen operating in the Merchandiser module and
in Front and Shelf Graphical view in In-Store Space Collaboration.

Gap

If a gap is set for a product, when that product is ungrouped, it will show the products
separated by the specified gap.

The bottom shelf in the above diagram shows the grouped products.

Note: while products are grouped, they are scales to show
the size including the gap.

The middle shelf shows a similar product but now ungrouped.
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The top shelf shows a similar product without a gap set.

Nested Products
The image below shows an example of nested products.

This option is typically used when objects like bowls or vases are stacked inside each
other.
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Other Product Studio Options
Find Option

The Find Option can be accessed from the View pull down menu or by pressing <Ctrl +
F>. To use the Find option, complete the following steps:
1. In the Find field, enter a value (wild cards such as ? are allowed).

Note: If no wild card is used, implied wildcards are
assumed: Find will search for all text containing the text
string.

2. Click the Search icon to bring up a list of products matching the search string.

3. Highlight the required item in the result list, and click on OK to open the pertinent
node in the Product hierarchy.

=
Find: [eoggs )

I T B
1K.g Keloggs Comilakes SK1E4
kg Kelloggs Crunchy Hut Comflskes SK1354

kg Kelloggs Fioshes SK1348

3!'39&:5@99: Ru;:iu:poc: sk
3509 kellaggs Coco Pops Chocolste SK1351 £

Display Style Types
The Display Style Types option is accessed from the View menu in Product Studio. The
Add, Edit and Delete icons on the toolbar allow the list to be configured.

=loix
+ & X

Hame iption Code

M Mutipad: MPE

P Palat PAL

T Tray TRY

1] Linit LNT

83 Other Product Studio Options



Display Style Types

Parameter Comment

Name The name should be a single character. This character must be unique as it acts as
the identifier (primary key) in the database.

Description ~ The description is the Display Style Type.

Code The code is used as look-up when importing data. It is often used when the third-
party database product data is being imported from does not have a display style
type description, but merely a code. The Code is also used when manually or semi-
automatically importing images to be associated with Display Styles.

The information is used to configure the list of Display Style Types that can be set in the
Size & Shape tab of the display Styles dialog box.
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Gede  [mmm | Qe Tl ~— Display Style Type

Sl [ mmrﬁ\

weghe 3 swe e 7]

Display Style Quantity

Lergth: Depu Feghts
Sze: [ T || =] | v
— r T 7 T
Cnshfacir (WE [ 7 i | 7
Gage I o [ o | (e |
swdes oo [ [ [
Mo Stacing [Focrga: | 7 T e | T
Cx ] oo |

If the Display Style quantity is set to anything other than 1, when the product is placed in
Merchandiser, the Quantity tab of the Add Products dialog box will show the total
number of units of merchandise placed.
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In the above example, 9 x 12 (=108) Display Styles has been placed. As each multi pack
contains six SKUSs, a total of 648 SKUs have been placed on that item of equipment.

Note: When reporting product quantities, the number of
items in multi packs, etc, should be taken into account.

Newly Imported Products

The Newly Imported Products dialog box allows users to find recently imported
products. These often require editing if imported from an external database. This is
because products defined in an external system may lack information required by Macro
Space Management such as dimensions or images.

It can be accessed from the View pull down menu and will populate upon being selected
with all products that have not been modified since the last import date.
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The toolbar allows users to close the dialog, edit a selected item, find an item or refresh
the list with the latest information from the database.

The Find dialog box is called from the toolbar.
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It allows users to find items in the list of newly imported products.

1. In the Find field, enter a value (wild cards such as ? are allowed).

Note: If no wild card is used, implied wild cards are
assumed: Find will search for all text containing the text
string.

Check the required fields in the Search frame.
Set the search direction and other options in the Options frame
Click on Find Next to highlight a product in the list.

Deleted Products

The Deleted Products dialog box contains the list of all products marked for deletion.

The toolbar allows users to close the dialog box, edit a selected product, find a product,
refresh the list of deleted products with the latest information from the database or
restore a deleted product to the product hierarchy.
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It allows users to find items in the list of newly imported products.
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1. In the Find field, enter a value (wild cards such as ? are allowed).

Note: If no wild card is used, implied wild cards are
assumed: Find will search for all text containing the text
string.

Check the required fields in the Search frame.
Set the search direction and other options in the Options frame
Click on Find Next to highlight a product in the list.

Purging Deleted Products

Deleted products can only be permanently removed from the database in the
Administration Module. From the Administration Module, select Tools - Purge. This
will bring up the Purge dialog as follows:
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Checking the Products option and clicking OK will result in products in the deleted items
list being permanently removed from the Macro Space Planning database. The results
will be confirmed in a dialog box.
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Example SHUExample S0U) deleted sucoesshidly

Example [tem{Example Them) deleted succassfully

Example Stybe(Example Style) deleted successfilly

Example Sub-Class (Exampis Sub-Class) deleted successfully i

Example Clase({Example Class) deleted suooesshilly __|;I
1 | 3
En]

Materials

The Materials option allows users to configure the Materials using to color equipment. It
is accessed from the View menu.

= Material colors can be added, edited or deleted using the toolbar.
= Transparency can range between 0 (opaque) to 100 (fully transparent).
= Shininess can range between 0 (matt) to 100 (shiny).
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Materials

= Specular values can range between 0 (light only reflects in one direction) to 100
(light reflects in all directions).

= Diffuse values can range between 0 (light is not diffused) to 100 (light is diffused
in all directions).
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